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Report Generator Help Guide 
Report Generator lets you create custom reports from multiple data sources. 
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Report Generator Features - Overview 
Open the Report Generator application. 

A quick overview of the features and capabilities of Report Generator. 

 

Report Generator is a web application developed by the Natural 
Resources Conservation Service (NRCS) National Water and 
Climate Center (NWCC). 

The application uses long-term snowpack, precipitation, reservoir, 
streamflow, and soils data from a variety of quality-controlled 
sources to create reports. 

Users can choose from predefined templates or build custom 
reports. 

Data from tabular reports may be exported to different formats, 
including comma-separated value (CSV) files. Charts can be 
saved to graphics formats, such as JPG and PNG. 

 

The Report Generator network incorporates data from many 
agency databases. The NRCS snow survey flagship database, the 
Water and Climate Information System (WCIS), provides a wealth 
of data, including manually-collected snow course data and 
information from automated Snow Telemetry (SNOTEL) and Soil 
Climate Analysis Network (SCAN) stations across the United 
States. 

Report Generator also uses precipitation, streamflow, and 
reservoir data from the U.S. Army Corps of Engineers (USACE), 
the U.S. Bureau of Reclamation (BOR), the Applied Climate 
Information System (ACIS), the U.S. Geological Survey (USGS), 
various water districts and other entities. 

 

In addition to creating reports, Report Generator lets you view 
information on sites, including "metadata," such as elevation, 
latitude/longitude and hydrologic unit code (HUC). 

View photos of the site, including a site map (in Google maps 
when available). 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
https://wcc.sc.egov.usda.gov/reportGenerator/


 
Report Generator Help Guide, National Water and Climate Center Page 3 of 51 

 

Report Generator creates reports in both tabular and chart 
format. Single-station and multiple-station charting is also 
supported. Data may be displayed in either English or Metric units. 

 

Who can benefit from using these data and products? 

Farmers, municipalities, water and hydroelectric utilities, 
environmental organizations, fish and wildlife managers, tribal 
nations, reservoir managers, recreationists, wetlands managers, 
urban developers, transportation departments, and research 
organizations regularly use our data 

 

Create a Single Station Report 
This tutorial describes how to create a custom report for a single station in Report Generator. The 
example will use a SNOTEL station (Site 526, Hogg Pass) to create a report which compares snow water 
equivalent (SWE) and snow depth data for the current year and the previous year. 

Step 1: Select station 

Start Report Generator. 

Select the Create/Modify Report tab. 

Add the Hogg Pass station to the Selected Stations list. In Select network: select SNOTEL from the 
dropdown list. 

In Enter station(s): enter 526 (the station ID for Hogg Pass). Optionally, enter the first few characters of 
the Station Name to activate the auto-fill capability. 

Select the Add button to add Station 526 to the Selected Stations list. 

 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
https://www.nrcs.usda.gov/wps/portal/wcc/home/dataAccessHelp/helpCenters/createSingleStationReport
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The Hogg Pass station is now the selected station for the custom report. 
  

Step 2: Select columns 

In the Select Columns pane, ensure the Data tab is selected. 

In the Element area, select snow water equivalent. Select Depth = None, Value Type = Value, Function 
= None. 

Select the Add button to add the element to the Manage Selected Columns list. 

 

In the Element area, select snow water equivalent. Change the Value Type to Previous Year's Value. 

Select the Add button to add the element to the Manage Selected Columns list. 

In the Element area, select snow depth. Select Depth = None, Value Type = Value, Function = None. 

Select the Add button to add the element to the Manage Selected Columns list. 

Repeat steps 6 and 7, using Previous Year's Value as the Value Type. The screen should look similar to 
the following. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Step 3: Determine column order 

The next step is to determine the order in which the columns will be displayed. 

To change the order of a column. Enable (select) the checkbox to the left of the snow water equivalent 
Previous Year's Value data type. 

Select the Move Down button. The snow water equivalent Previous Year's Value will move down one 
level in order. 

 

 

The report will contain snow water equivalent and snow depth data for the current year, followed by 
snow water equivalent and snow depth data for the previous year for the Hogg Pass station (526). 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Now that the data types and order of the columns are complete, it's time to determine the layout of the 
final report. 
  

Step 4: Determine report layout 

For this example, the initial report will be generated with a frequency of monthly and a time series 
layout. 

In the Select Time Period, Layout, and Units pane, select the following: 

Frequency = Monthly 
Report Instantaneous Data As = Start of Period  
Time Period = Current Calendar Year and All Months 
Layout = Time Series 
Units = English 
Output Format = HTML 

 

The report will contain snow water equivalent and snow depth data for the current year, followed by 
snow water equivalent and snow depth data for the previous year for the Hogg Pass station (526). 

Now that the data types and order of the columns are complete, it's time to determine the layout of the 
final report. 

  

Step 5: Create the report 

Now that the station has been identified, the data types and their order defined, and the look and feel 
of the final report determined, it's time to view the report and analyze the results. 

Select the  button. The results of the report are displayed in the View Report tab. 

Note that snow water equivalent and snow depth data are displayed for the current and previous year 
for the Hogg Pass station (526). 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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To save the results of the report in comma-separated value format, select CSV from the Output 
Format dropdown list. A web page will open with the data from the report displayed. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Right-click on this web page and select Save as... 

Save the file with a .csv extension. 

To change the report from tabular to chart view, select Chart from the Layout drop-down menu. The 
table will display as a chart, similar to the one shown below. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Create a Multi-Station Report 

This tutorial describes how to create custom reports for multiple stations in Report Generator. The example will use 
several SNOTEL (Snow Telemetry) stations in the state of Oregon to compare standard elements and generate two 
reports: a multi-station report grouped by element and a multi-station chart. 

Step 1: Select stations 

Start Report Generator. 

Select the Create/Modify Report tab. 

Add stations to the Selected Stations list. In Select network: select SNOTEL from the dropdown list. 

In Enter station(s): enter 619 (the station ID for McKenzie). Optionally, enter the first few characters of the Station Name to 
activate the auto-fill capability. 

Select the Add button to add Station 619 to the Selected Stations list. 

 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
https://www.nrcs.usda.gov/wps/portal/wcc/home/dataAccessHelp/helpCenters/createMultiStationReport
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Repeat Steps #4 and #5 to add each of these stations to the Selected Stations list: 

-   719 Roaring River 
-   733 Santiam Junction 

When finished, there should be three stations in the Selected Stations list. 

 

  

Step 2: Select columns 

The next step is to determine the data columns which will be part of the multi-station report. For this tutorial, we will add two 
data columns (snow water equivalent and precipitation accumulation) and a metadata column (HUC) to display for the multiple 
stations. 

Add the data columns. In the Select Columns pane, select the Data tab. 

For element, select air temperature average. Depth = None, Value Type = Value, Function = None. 

Select the Add button to add the element to the Manage Selected Columns list. 

Repeat Steps 2 and 3, this time selecting the snow depth element. 

The display should look similar to the following.  

 

Step 3: Determine report layout 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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For this example, the report will be generated with a frequency of Water Year, a time period of the Last 3 Water 
Years and Water Year - Group by Month layout. 

In the Select Time Period, Layout, and Units pane, select the following: 

Frequency = Monthly 
Report Instantaneous Data As = Start of Period  
Time Period = Last 12 Months, All Months 
Layout = Stacked Time Series 
Units = English 
Output Format = HTML 

 

Step 4: Generate the report 

Now that the stations have been identified, the data types and their order defined, and the look and feel of the final report 
determined, it's time to generate the report and analyze the results. 

Select the  button. The results of the report are displayed in the View Report tab. 

Note that Air Temperature Average and Snow Depth data are displayed for the last 12 months for the three selected stations. 
Note, too, that Report Generator automatically added the Site ID and Site Name into the report. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Tip: To save the results of the report, select the Export icon ( ). Use the Layout, Units, and Time Period menus to change 
the output of the report. 

The final step in this tutorial is to create a multi-station chart. 

In the Layout dropdown list, select Chart. 

Select the  button. 

Depending on the time of year the tutorial is completed, a chart similar to the one shown displays. 

 

 

Create a Daily Soil Summary 

This tutorial describes how to create a daily soil data summary for a single station in Report Generator. The example 
will use a Soil Climate Analysis Network (SCAN) station (Site 2015, Adams Ranch) to create a report which 
summarizes soil moisture and soil temperature at three depths for the last 30 days. 

Step 1: Select station 

1. Start Report Generator. 
2. Select the Create/Modify Report tab. 
3. Add the Adams Ranch SCAN station to the Selected Stations list. In Select network: select SCAN from the 

dropdown list. 
4. In Enter station(s): enter 2015 (the station ID for Adams Ranch). Optionally, enter the first few characters of 

the Station Name to activate the auto-fill capability. 
5. Select the Add button to add Station 2015 to the Selected Stations list. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
https://www.nrcs.usda.gov/wps/portal/wcc/home/dataAccessHelp/helpCenters/createDailySoilSummary
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The Adams Ranch station is now the selected station for the custom report. 

Step 2: Select columns 

The next step is to determine the data columns which will be part of the single station report. For this tutorial, we will 
add columns to display the previous 30 day's soil moisture percentage at three depths (2', 8", and 20") for the Adams 
Ranch station. 

1. In the Select Columns pane, ensure the Data tab is selected. 
2. In the Element area, select soil moisture percent. 
3. Set Depth to -2", Value Type to Value, Function to Mean, and Function Interval to Hourly. 
4. Select the Add button to add the element to the Manage Selected Columns list. 

 

5. Repeat Steps 3 and 4, using the Depths -8" and -20". 
6. Select the Add button to add each depth to the Manage Selected Columns list. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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7. Next, in the Element area, select soil temperature observed.  
8. Set Depth to -2", Value Type to Value, Function to Mean, and Function Interval to Hourly. 
9. Select the Add button to add the element to the Manage Selected Columns list. 

 

10. Repeat Steps 8 and 9, using the Depths -8" and -20". 
11. Select the Add button to add each depth to the Manage Selected Columns list. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Soil moisture and soil temperature data at depths of -2", -8", and -20" will be reported on an hourly mean basis for the 
Adams Ranch SCAN station (2015). 

Now that the data types are selected, it's time to determine the layout of the final report. 

Step 3: Determine report layout 

For this example, the initial report will be generated with a frequency of monthly and Standard (non-grouped) layout. 

1. In the Select Time Period, Layout, and Units pane, select the following: 

Frequency = Daily 
Report Instantaneous Data As = Start of Period  
Time Period = Last 30 Days, All Months, and All Days 
Layout = Time Series 
Units = English 
Output Format = HTML 

 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Step 4: Generate the report 

Now that the station has been identified, the data types and their order defined, and the look and feel of the final 
report determined, it's time to generate the report and analyze the results. 

1. Select the  button. The results of the report are displayed in the View Report tab. 

 

Note that mean hourly soil moisture and soil temperature data are displayed for three depths (-2", -8", and -20") for 
the last 30 days for the Adams Ranch station (2015). 

2. To change the report from tabular to chart view, select Chart from the Layout drop-down menu. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Tip: To save the results of the report, select the CSV icon ( ) from the Output Format dropdown list. Use 
the Layout, Units, and Time Period menus to change the output of the report. 

Tip: To save the chart in a graphics format, select the  button. Right click the image 
and select Save image as... to save to a format such as .png or .jpg. 

 

View Station Information Panel: Select Predefined Reports 

This tutorial shows how to work with predefined reports in Report Generator. There are two types of predefined 
reports: 

• Data Reports. These reports are based on several standard elements (such as precipitation or snow depth), 
values, and time periods. 

• Metadata Reports. These reports are based on current and historic sensor data and site information.  

Note:This tutorial uses the set of the Data Reports and Metadata Reports that are available in the current release of 
Report Generator. Your version of Report Generator may have additional reports available. 

The tutorial consists of three, short lessons: 

• Lesson 1 shows how to display the different predefined Data Reports in the View Reports pane. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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• Lesson 2 shows how to take the results in the View Reports pane and save them to a .csv (comma-
separated value) file for further analysis. 

• Lesson 3 shows how to quickly change the layout of a Data Report from tabular view to chart view. 

Lesson 1: View Report 

1. Start Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the station. In the Enter station(s) field, enter the following station ID: 526. 
4. Station 526, Hogg Pass, will be added to the Selected Stations list. When a station is added, the View 

Station Information link appears in the upper left corner of the application. 

 

5. Select the View Station Information link. The Station View panel will open, displaying the station name, 
station metadata (such as Network, County, Elevation, Latitude, and Longitude), a site photo and a link to 
the site in Google Maps. 

 

6. From the Station View pane, hover over the the Reports dropdown list and select Standard Sensors-
Hourly. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center


 
Report Generator Help Guide, National Water and Climate Center Page 20 of 51 

 

7. A report opens with hourly standard sensor data for the Hogg Pass site for the last seven days. 

 

8. Next, select Daily Sensor Descriptions from the Metadata Reports dropdown list. The data changes to 
reflect the complete list of sensor descriptions for the Hogg Pass site. 

 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Try the remaining selections in the Reports dropdown list to see what’s available. You may also want to use the Time 
Period dropdown to modify the frequency and time period selections for the report. 

Lesson 2: Export Data 

This lesson uses components in the View Report tab to take the data from the Standard Sensors-Daily report and 
save it to a .csv (comma-separated value) file for further analysis. 

1. Go to the Reports dropdown list and select Standard Sensors-Daily. The predefined report displays. 

 

2. In the View Report tab, select CSV from the Output Format dropdown menu.. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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3. A web page will open with the data from the report displayed. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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4. Right click on this web page and select Save as... 
5. Save the file with a .csv extension. 

Lesson 3: Change from Standard to Chart Layout 

This lesson uses the Layout dropdown menu in the View Report tab to change the display of the Standard Sensors-
Daily report from tabular to line chart view. 

1. If not already there, go to the Reports dropdown list and select Standard Sensors-Daily. The predefined 
report displays in the View Report tab. 

2. In the View Report tab, select Chart from the Layout dropdown list. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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3. The report will change to chart format. 

 

4. To save the chart, select Export Chart as Image. 
5. Right click on the image, select Save Image As... and save the file to a graphics format, such as .png or 

.jpg. 
6. To return to tabular format, select Standard from the Layout dropdown list. 

 

Managing Stations 
 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Add a Station 

This tutorial describes how to add stations to a report in Report Generator. 

1. Open Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the network. In the Select network: field choose a network from the dropdown list. This tutorial 

uses the SNOTEL network as an example. 
4. Choose the station. Stations may be selected using either the Station Name or the Station ID. This field 

auto-suggests entries as you type. In the Enter station(s): field, enter the following station ID:  526. 
5. Select the Add button. 
6. Station 526, Hogg Pass, will be added to the Selected Stations list. 

 

This completes the Add a Station tutorial. Now it's time to learn how to remove stations from a report. 

 

Remove a Station 
 

This tutorial describes how to remove stations from a report in Report Generator. First, we will add a station to the 
Selected Stations list. Then, we will remove that station from the list. 

1. Open Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the network. In the Select network: field choose a network from the dropdown list. This tutorial 

uses the SNOTEL network as an example. 
4. Choose the station. Stations may be selected using either the Station Name or the Station ID. This field 

auto-suggests entries as you type. In the Enter station(s): field, enter the following station ID:  526. 
5. Station 526, Hogg Pass, will be added to the Selected Stations list. 
6. To remove the Hogg Pass station, simply click the Remove link at the right of the station name. 

 

Tip: If you have many stations defined and wish to remove all of them from the Selected Stations list, select 
the Remove All link. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
https://www.wcc.nrcs.usda.gov/report_generator/networks.htm
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Tip: Use the Sort By: dropdown selection box to sort the list of stations by various criteria, such as Station ID or 
HUC. 

This completes the Remove a Station tutorial.  If you understand adding and removing stations, move on to 
the Perform an Advanced Search tutorial. 

 

Perform an Advanced Station Search 

This tutorial describes how to search for stations in Report Generator. This is an alternative to selecting stations one-
by-one in the Select Stations list. The tutorial assumes that several stations have already been added to 
the Selected Stations list. 

1. Open Report Generator. 
2. Select the Create/Modify Report tab. 
3. Select the Advanced Search link. 

 

4. The Advanced Search page opens. 
5. In the Station Selection Criteria area, select search criteria from one or more of the entry fields. 
6. Select the Search button to show the stations that match the search criteria. 
7. Optionally, add individual stations that don't meet the specified criteria. This works like the Add 

Stations field in the Create/Modify Report tab. 
8. Specify the sort order for the stations in the Sort By: dropdown list. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Adding Additional Stations 

Sometimes you'll need to add stations to your selection that do not match your selection criteria. For example, let's 
say you wanted all of the SNOTEL stations in Oregon, but also wanted to include one station from Washington. In 
this case, you would set the "State" field to "OR" and select the Network SNOTEL, select the Search button, and 
then add the additional station using the "Enter station(s)" input field in the Add additional stations section. This 
section works the same as the way you enter stations on the main Create/Modify Report page. You simple pick a 
network in the Select Network menu, and then enter the first few characters of the station id or station name to add 
and then click the station that you want to add. Stations that are added individually can be removed individually by 
clicking on the Remove link in the Actions column in the table of selected stations. 

Note: Stations in the table that are a result of the station selection criteria will not have anything in the Actions 
column. 

Close Button 

Pressing the Close button will close the window and return you to the Create/Modify Report tab in Report 
Generator. When you return to the Create/Modify Report tab, any changes that you had made in the Advanced 
Station Selection screen will be reflected in the Selected Stations table. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Define Search Criteria and Filtering 

There are many ways to search for the stations using the Advanced Search feature in Report Generator. In the top 
left quadrant of the Advanced Search page is a Station Selection Criteria section. Each of the text fields accepts a 
comma-separated list of wildcard patterns (only the asterisk '*' and '?' wildcard characters are understood). 

The following table describes the different search criteria fields: 

 

Search 
Field Description 

Station ID 
The station id of the stations. This can include wildcards and can be a comma 
separated list of station ids. If wildcards are used, the '*' can be used to match any 
number of characters and the '?' can be used to match a single character. 

Station 
Name 

The name of the station. This can include wildcards and can be a comma separated 
list of station names or station names with wildcards. 

State 

The two-character state FIPS alphabetic code (such as 'OR' for Oregon or 'WA' for 
Washington). This can be a single state code or a comma separated list of state 
codes. 
 
There is also an undocumented feature that allows you to search for stations under 
the jurisdiction of a particular Data Collection Office (DCO) by entering the 2-
character state code of the DCO followed by the letters 'DCO'. For example, if you 
want to search for stations in the Oregon DCO, type 'ORDCO' in the 'State' search 
field. You can enter more than more DCO in the same way that you enter more 
than one state. You can also enter a state and a DCO, but what results is the 
intersection of the DCO and the states entered (if you enter ORDCO and OR, 
you'll get only the stations that are in OR and in ORDCO) 

Network 

The network code of the station(s). Zero, one, or more networks can be selected. 
To select a single network, just click on the item. To deselect a network or to add 
another network to the selection hold down the CTRL key and click on the 
network to select or deselect. 

HUC The hydrologic unit code. You can enter one or more 2, 4, 6, or 8 digit HUCs 
separated by commas. 

Min/Max 
Elev 

The minimum and maximum elevation of the stations. None, one, or both of these 
filter fields can be specified. 

Active 
Sites Only 

If this box is checked, only stations that are still active will be returned. If this is 
unchecked, any station that matches the search criteria will be returned, even if the 
station is no longer in service. 

Elements Used to select the elements that a station should have data for. If multiple elements 
are selected, a station will be returned if it has at least one of the elements selected 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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When the filter is executed, there is an "OR" operator placed between the comma separated items 
in a given field and an "AND" operator placed between the various filter fields. 

Following are some examples which illustrate how to use the filtering capabilities: 

Example 1 - Find station 10360900 

Station : 103060900 

State : 

Network : 

HUC : 

Min/Max Elev : 

Example 2 - Find all stations in California or Nevada 

Station : 

State : CA, NV 

Network : 

HUC : 

Min/Max Elev : 

Example 3 - Find all streamflow or reservoir stations in California or Nevada where the station name 
begins with "LAKE" 

Station : LAKE* 

State : CA, NV 

Network : USGS (STREAM), BOR (RESV) 

HUC : 

Min/Max Elev : 

Example 4 - Find all SNOTEL stations whose elevation is between 1000 and 7000 feet and are in HUC 
18 

Station :  

State :  

Network : SNOTEL/SCAN  

HUC : 18 

Min/Max Elev : 1000 to 7000 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center
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Example 5 - Find all stations in Oregon that have incremental precipitation 

Station : 

State : OR  

Network :  

HUC :  

Min/Max Elev :  

Elements : precipitation increment 
 

 

Managing Columns 
 
Add a Data Element Column 

This tutorial describes how to add data element columns to a report in Report Generator. The example adds two 
columns for "air temperature maximum" using Value Types of this year's and the previous year's values. 

1. Open Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the network. In the Select network: field choose a networkfrom the dropdown list. This tutorial uses 

the SNOTEL network as an example. 
4. Choose the station. Stations may be selected using either the Station Name or the Station ID. This field 

auto-suggests entries as you type. In the Enter station(s): field, enter the following station ID:  526. The 
Hogg Pass station displays in the Selected Stations list. 

5. In the Select Columns pane, select the Data tab. 
6. Under Element, select "air temperature maximum." 
7. Under Depth, select "None." 
8. For Value Type, select 'Value." 
9. For Function, select "None." 
10. Select the Add button to add the element to the Manage Selected Columns list. 
11. Ensure the element "air temperature maximum" with a value type of "Value" appears at the bottom of 

the Manage Selected Columns list. 
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1. Under Element, ensure "air temperature maximum" is selected. 
2. Under Depth, keep "None" 
3. For Value Type, select "Previous Year's Value." 
4. For Function, select "None." 
5. Select the Add button to add the element to the Manage Selected Columns list. 
6. Value Type, select "Previous Year's Value." 
7. Ensure the element "air temperature maximum" with a value type of "Previous Year's Value" appears at the 

bottom of the Manage Selected Columns list. 
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Add a Metadata Column 

This tutorial shows how to add a metadata column to a report in Report Generator. The example adds a column for 
the Hydrologic Unit Code (HUC) metadata type to the report. 

Note: If you are continuing this tutorial from the Add a Data Element Column tutorial, go to Step 4. 

1. Start Report Generator, 
2. Choose the Create/Modify Report tab. 
3. Add a station. In the Select Stations Enter Station(s) field, enter 526. The Hogg Pass station is added to the 

Selected Stations list. 
4. In the Select Columns  pane, select the Metadata tab. 
5. Under Metadata, select Hydrologic Unit Code (HUC). 
6. Select the Add button. 
7. Ensure the metadata type HUC appears at the bottom of the Manage Selected Columns list. 

 

 

Change Column Order 

This tutorial shows how to change the order that columns appear in a report in Report Generator. It also shows how 
to change the sort order of a column in a report. The example moves the metadata element HUC2 (2-digit HUC) to 
the top of the order. The final report will therefore display the HUC as the first item in the report, followed by air 
temperature minimum and air temperature maximum. 

Note: If you're continuing this tutorial from the Add a Metadata Column tutorial, go to Lesson 2: Change order of 
data types. 

Lesson 1: Add data types 
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1. Start Report Generator. 
2. Select the Create/Modify Report tab 
3. Add a station. In the Select Stations Enter station(s) field, enter 526. The Hogg Pass station is added to the 

Selected Stations list. 
4. Add an element. In the Select Columns pane, select the Data tab. 
5. Under Element, select "air temperature minimum." 
6. Under Depth, select "None." 
7. For Value Type, select 'Value." 
8. For Function, select "None." 
9. Select the Add button to add the element to the Manage Selected Columns list. 
10. Add a second element for the previous year. Under Element, ensure "air temperature maximum" is selected. 
11. Under Depth, keep "None" 
12. For Value Type, select "Previous Year's Value." 
13. For Function, select "None." 
14. Select the Add button to add the element to the Manage Selected Columns list. 
15. Add another element. Under Element, select "snow water equivalent." 
16. Select the Add button. 

The display should look similar to the following. 

 

Lesson 2: Change order of data types 

1. Enable the checkbox next to the snow water equivalent Data Type.

 

2. Select the Move Up button. The snow water equivalent Data Type will move up one level in 
order. 

3. Select the Move Up button again. The snow water equivalent Data Type will move to the top of 
the list, and will therefore appear as the first column on the final report.
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Lesson 3: Change sort order of columns in report 

1. In the Select Time Period, Layout, and Units pane, select the following: 
o Interval/Duration = Daily 
o Report Instantaneous Data As = Start of Period 
o Time Period = Last 7 Days, All Months, All Days 
o Layout = Time Series 
o Units = English 
o Output Format = HTML 

2. Select the View Report button. A report similar to the following will open 

 

Note that each column in the report has Up/Down arrows next to the column heading. The 
Up/Down arrows allow you to sort the columns as follows: 
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Take some time to explore how each sort option works for each column in the report. 

 

Remove Columns 

This tutorial shows how to remove columns from a report in Report Generator. The first example removes a single 
data type from the report. The second example then removes all data types from the report. 

1. Start Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the station. In the Enter station(s) field, enter the following station ID: 526. 
4. Station 526, Hogg Pass, will be added to the Selected Stations list. When a station is added, the View 

Station Information link appears in the upper left corner of the application. 
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5. Select the View Station Information link. The Station View panel will open, displaying the station name, 
station metadata (such as Network, County, Elevation, Latitude, and Longitude), a site photo and a link to 
the site in Google Maps. 

 

6. From the Station View pane, hover over the the Reports dropdown list and select Standard Sensors-
Hourly.  
 
Note: The Reports and Metadata Reports dropdown lists contain pre-defined reports for commonly-used 
data elements. 

 

7. Under Manage Selected Columns, enable the checkbox next to the snow water equivalent data type. 
8. Select the Remove Selected Columns link. The data type will be deleted from the list. 
9. Next, select the Remove All link. All the data types will be removed from the list. 
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Managing Report Types 
 
Select Frequency and Time Period 

This tutorial shows how to use the Frequency and Time Period selections in Report Generator. Frequency and Time 
Period are interactive; options change depending on the frequency or time period selected. 

The Frequency selection determines how often data is supplied to a report in Report Generator. The Time 
Period selection determines the duration of the report and the number of days to include in the report. 

The example uses a Standard data report (Standard Sensors - Daily) to change the frequency and time period of 
data displayed in the View Report tab. 

1. Start Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the station. In the Enter station(s) field, enter the following station ID: 526. 
4. Station 526, Hogg Pass, will be added to the Selected Stations list. When a station is added, the View 

Station Information link appears in the upper left corner of the application. 
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5. Select the View Station Information link. The Station View panel will open, displaying the station name, 
station metadata (such as Network, County, Elevation, Latitude, and Longitude), a site photo and a link to 
the site in Google Maps. 

6. From the Station View pane, hover over the Reports dropdown list and select Standard Sensors-Daily. A 
tabular report will open, displaying the snow water equivalent, snow depth, precipitation, and temperature 
min/max/averages for the Hogg Pass site for the last 30 days. 
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7. To change the frequency and time period for which data are reported, select the Time Period dropdown list 
on the report. 

8. In the Time Period tab, change the Frequency to Monthly, the Report Instantaneous Data as: to Start of 
Period, and the Time Period to Last 12 Months and All Months. 
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9. Select Apply. The data in the View Reports tab change to reflect a reporting frequency of monthly and a 
time period of the last 12 months. 
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Select Units of Measurement 

This tutorial shows how to change the Units selections in Report Generator. Available units of measurement are 
English and Metric. 

The example uses a Standard data report (Snow Depth) to change the unit of measurement for data displayed in 
the View Report tab. 

1. Start Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the station. In the Enter station(s) field, enter the following station ID: 526. 
4. Station 526, Hogg Pass, will be added to the Selected Stations list. When a station is added, the View 

Station Information link appears in the upper left corner of the application. 

 

5. Select the View Station Information link. The Station View panel will open, displaying the station name, 
station metadata (such as Network, County, Elevation, Latitude, and Longitude), a site photo and a link to 
the site in Google Maps. 

6. From the Station View pane, hover over the Reports dropdown list and select Snow Depth. A tabular report 
will open, displaying the snow water equivalent, change in snow water equivalent, snow depth, and change 
in snow depth for the Hogg Pass site for the last 30 days in inches. 
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7. In the View Report tab, select Metric from the Units drop-down list. The units on the report will change from 
English to Metric. 
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Select Layout 

This tutorial shows how to choose the layout (format) of the report in Report Generator. Available layout options are: 

• Time Series. Single station or multi-station report. The report will display for all stations defined with 
elements listed on a per-station basis. That is, each report will include all elements for that station for the 
time period defined. For example: 

 

• Stacked Time Series. Multi-station report. The report will display all stations with elements listed on a per-
station basis. For example: 

 

• Water Year - Group by Month. Single station or multi-station report. The report will display for all elements 
defined, grouped by month for the current water year (Oct. 1-Sept. 30). For example: 

 

• Calendar Year - Group by Month. Single station or multi-station report. The report will display for all 
elements defined, grouped by month for the current calendar year (Jan. 1-Dec. 31). For example: 

 

• Chart. Single station or multi-station chart. Report Generator will display a line chart for all elements and all 
the stations defined. For example: 
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The following tutorial uses a Standard data report (Snow Depth) to change the layout for data displayed in the View 
Report tab from Standard to Chart. 

The tutorial consists of two, quick lessons: 

• Lesson 1: Change layout from Standard to Group Elements by Month 
• Lesson 2: Change layout from Standard to Chart 

Lesson 1: Change Layout from Standard to Group Elements by Month 

1. Start Report Generator. 
2. Select the Create/Modify Report tab. 
3. Choose the station. In the Enter station(s) field, enter the following station ID: 526. 
4. Station 526, Hogg Pass, will be added to the Selected Stations list. When a station is added, the View 

Station Information link appears in the upper left corner of the application. 
5. Select the View Station Information link. The Station View panel will open, displaying the station name, 

station metadata (such as Network, County, Elevation, Latitude, and Longitude), a site photo and a link to 
the site in Google Maps. 

6. From the Station View pane, hover over the Reports dropdown list and select Standard Sensors-Daily. A 
tabular report will open, displaying the snow water equivalent, snow depth, precipitation accumulation, and 
air temperature minimum, maximum and average for the Hogg Pass site for the last 30 days. 

 

1. In the View Report tab, select Water Year - Group by Month in the Layout drop-down list. The report will 
change from elements being listed on a per-station basis to elements being listed on a per-month basis. 
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Continue to Lesson 2: Change Layout from Standard to Chart. 
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Lesson 2: Change Layout from Standard to Chart 

1. In the View Report tab, select Chart from the Layout drop-down list. The report will change from a tabular 
format to a line chart. 

 

 

Tip: To save the results of this report: 
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• From the Output Format drop-down list, select the csv format icon ( ) to save the file to a comma-
separated value (.csv) format or to an Excel (.xls) spreadsheet. 

• To save the chart to a graphics format such as .jpg or .png, select the Export Chart as Image button, then 
right-click on the image to save it. 

 

Frequently-Asked Questions 
Answers to questions from our users. 

Report Generator Frequently-Asked Questions 

Q Does Report Generator have any predefined report formats I can use? 

A Report Generator has several predefined reports available. When you add a station to Report 
Generator, the View Station Information link to open the Station View pane. 

In the Station View pane, the Reports and Metadata Reports () dropdown menus contain several 
predefined report templates. For example, choose from both hourly and daily standard sensor reports, 
snow depth, daily snow water equivalent medians and averages, and sensor metadata reports. 

    

Q What are the sources of data Report Generator uses? 

A   

Report Generator uses data from the National Resources Conservation Service (NRCS) Water and 
Climate Information System (WCIS) databases. This includes manually-collected snow course data and 
information from automated Snow Telemetry (SNOTEL) and Soil Climate Analysis Network (SCAN) 
stations. 

 

Report Generator also uses precipitation, streamflow, and reservoir data from the U.S. Army Corps of 
Engineers (USACE), the U.S. Bureau of Reclamation (BOR), the National Weather Service (NWS), the 
Applied Climate Information System (ACIS), the U.S. Geological Survey (USGS) and various water districts 
and other entities. 

 

    

Q I created a tabular report in Report Generator. Is it possible to export this data for further 
analysis? 

A Yes. In the View Report tab, select the CSV icon () from the Output Format  dropdown list (). A 
web page will open with the data from the report displayed. Open a text editor (such as Notepad or 
Excel). Copy and paste lines that do not begin with a pound sign (#) into the text editor. Save the file 
with a .csv extension. 
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Q I created a chart in Report Generator. Can I save this chart to another format? 

A Charts may be saved to a graphics format or exported to another format (such as .csv. or .xls). 

To save the chart in a graphics format, select the Export Chart as Image button (). When the file opens, 
right-click the chart and select Save image as... Save the file to a graphics format, such as .png or .jpg. 

 

To export the data to .csv or .xls format, in the View Report tab, select the CSV icon () from the Output 
Format dropdown list (). A web page will open with the data from the report displayed. Open a text 
editor (such as Notepad or Excel). Copy and paste the data from the web page into the text editor. Save 
the file with a .csv extension. 

 

    

Q I'm using Internet Explorer as my browser. Many of the functions of Report Generator aren't 
working correctly. 

A Report Generator 2.0 won't function properly in Internet Explorer if Compatibility View is 
enabled, or if the USDA.gov domain has been added to Compatibility View. To disable Compatibility 
View, go to Tools > Compatibility View Settings in Internet Explorer, and disable (uncheck) the Display 
Intranet Sites in Compatibility View checkbox. If USDA.gov is in the  Websites you've added to 
Compatibility View list, highlight USDA.gov and select the Remove button. 

    

Q I want to create a report for all the sites within a basin, but I don't know the site names or 
station IDs. Can Report Generator find those sites? 

A If you know all or part of the Hydrologic Unit Code (HUC) for the basin, you can use the 
Advanced Search feature in Report Generator to quickly define a list of sites within the basin. Simply 
select the data Network, then enter the HUC for the basin (1-12 digits, wildcards are accepted), and 
select Search. 

    

Q Can Report Generator be used to create multi-station charts? 

A Yes. Version 2.0 of Report Generator supports multi-station charting. 
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Announcements and Release Notes 
Contains important information associated with updates and changes to Report Generator. It also 
contains Release Notes describing recent enhancements and defect fixes. 

https://www.nrcs.usda.gov/conservation-basics/natural-resource-concerns/water/national-water-and-climate-center

	Report Generator Features - Overview
	Create a Single Station Report
	Create a Multi-Station Report
	Create a Daily Soil Summary
	View Station Information Panel: Select Predefined Reports
	Managing Stations
	Add a Station
	Remove a Station
	Perform an Advanced Station Search
	Define Search Criteria and Filtering

	Managing Columns
	Add a Data Element Column
	Add a Metadata Column
	Change Column Order
	Remove Columns

	Managing Report Types
	Select Frequency and Time Period
	Select Units of Measurement
	Select Layout

	Frequently-Asked Questions
	Announcements and Release Notes

